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ΔΩΔΕΚΑΤΗ ΕΡΓΑΣΤΗΡΙΑΚΗ ΕΝΟΤΗΤΑ : ΕΙΣΑΓΩΓΗ ΤΗΣ ΕΝΤΟΛΗ ΓΙΑ ΤΗΝ ΔΗΜΙΟΥΡΓΙΑ BLOCK   

ΕΙΣΑΓΩΓΗ ΤΗΣ ΕΝΤΟΛΗΣ: Για δημιουργία block 
Pull down menu: Draw → Block → Make 
 

ΥΠΟΜΕΝΟΥ ΤΗΣ ΕΝΤΟΛΗΣ: 
Block name:    Δίνουμε όνομα στο block που θα δημιουργήσουμε. 
 

Subject objects:    Επιλέγουμε τα αντικείμενα που θα αποτελούν το block Επιλέγουμε είτε 
στοχεύοντας ένα- ένα τα αντικείμενα με τον κέρσορα μας είτε δημιουργώντας ένα 
πλαίσιο κινούμενοι από αριστερά προς τα δεξιά οπότε επιλέγονται τα αντικείμενα 
που περιλαμβάνονται πλήρως στο πλαίσιο αυτό είτε δημιουργώντας ένα πλαίσιο 
κινούμενοι από δεξιά προς τα αριστερά οπότε επιλέγονται τα αντικείμενα που 
περιλαμβάνονται πλήρως αλλά και τα αντικείμενα που τέμνονται από το πλαίσιο 
αυτό. Μετά την επιλογή των αντικειμένων φαίνεται το πλήθος τους στο Number 
found: 

 
Retain Objects:     Αν θέλουμε να παραμείνουν τα αντικείμενα που αποτελούν το block, στην 

σχεδιαστική οθόνη και μετά το τέλος δημιουργίας του block 

 
Base point 

Select point:           Επιλογή του σημείου από το οποίο θα κρατώ το block κατά την εισαγωγή του στην 
σχεδιαστική οθόνη. Αυτό μπορεί να γίνει με επιλογή ενός σημείου στην 
σχεδιαστική οθόνη ή με εισαγωγή των συντεταγμένων του σημείου αυτού στα 
αντίστοιχα παράθυρα των χ, ψ, ζ συντεταγμένων όπως φαίνεται στην καρτέλα. 

 
 
 

ΕΙΣΑΓΩΓΗ ΤΗΣ ΕΝΤΟΛΗΣ: ΓΙΑ ΕΙΣΑΓΩΓΗ ΕΝΟΣ BLOCK 
Pull down menu: Insert → Block  

 

ΥΠΟΜΕΝΟΥ ΤΗΣ ΕΝΤΟΛΗΣ: 
Βlock:        Ανοίγω των λίστα των block του αρχείου και επιλέγω με το όνομα του το οίοοίί που θέλω 

να εισάγω. 
File:         Ψάχνω το block σε κάποιο άλλο αρχείο 
Οptions:       Για την εισαγωγή του οίοοίί στο σχέδιο μπορώ να καθορίσω τις παραμέτρους σημείου 
εισαγωγής, κλίμακας και γωνίας στροφής είιε στην σχεδιαστική επιφάνεια είτε από την παραπάνω 
καρτέλα στα αντίστοιχα σημεία υΐδβτϋοη ρουΛ, &03ΐβ, Κοί&ίίοη 
Αν κατά την εισαγωγή του block θέλω αυτό να σπάει στα αντικείμενα από τα οποία αποτελείται 
τσεκάρω την επιλογή explode. 
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ΧΡΗΣΙΜΟΤΗΤΑ ΤΩΝ BLOCK 
Σχήματα και στοιχεία τα οποία επαναλαμβάνονται πολύ συχνά κατά τον σχεδιασμό και των οποίων 
η μορφή δεν αλλάζει αποθηκεύονται σαν μπλοκ και μ' αυτό τον τρόπο εισάγονται κάθε φορά στην 
κατάλληλη θέση χωρίς να χρειάζεται ο εξ αρχής σχεδιασμός τους. 
 
Draw → Block → Make→ Select objects:  Επιλέγουμε τα αντικείμενα που θα αποτελούν το 
μπλοκ Block name: Δίνουμε το όνομα με το οποίο θέλουμε να αποθηκευτεί το μπλοκ Insertion 
Point: 
Δίνουμε το σημείο από το οποίο θα «πιάνεται» το μπλοκ κατά την εισαγωγή του στο σχέδιο. 
 
Insert → Block → block: Και επιλέγουμε το μπλοκ που θέλουμε να εισάγουμε. Στην συνέχεια 
μπορούμε να αλλάξουμε από την command line την κλίμακα του μπλοκ. 
Παρατήρηση: Τα στοιχεία που ανοίκουν σ' ένα μπλοκ μετά την εισαγωγή του μπλοκ αποτελούν ένα 
αντικείμενο. Για να κάνουμε μορφοποιήσεις μεμονωμένα σε κάποια αντικείμενα κάνω βχρίοάε στο 
μπλοκ. 
 
ΔΙΑΦΟΡΑ BLOCK - WBLOCK 
Μέσω της εντολής block δημιουργούμε μία λίστα από μπλοκ τα οποία σώζονται στο συγκεκριμένο 
αρχείο που τα δημιουργήσαμε. 
Μέσω της εντολής wblock δημιουργούμε μία λίστα από μπλοκ τα οποία αποθηκεύονται στον σκληρό 
δίσκο του υπολογιστή και μπορούμε να τα χρησιμοποιήσουμε και σε άλλα σχέδια. 
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ΔΕΚΑΤΗ ΤΡΙΤΗ ΕΡΓΑΣΤΗΡΙΑΚΗ ΕΝΟΤΗΤΑ : ΕΙΣΑΓΩΓΗ ΤΗΣ ΕΝΤΟΛΗ ΓΙΑ ΤΗΝ ΔΗΜΙΟΥΡΓΙΑ LAYERS   

ΕΛΕΓΧΟΣ ΤΩΝ ΕΠΙΠΕΔΩΝ ΤΟΥ ΣΧΕΔΙΟΥ: 
 
 

Command:                    Layer ↲  ή La ↲ 

 

Pull down menu:               Format    →  Layer 

Εικονίδια:        Ενεργοποιούμε το εικονίδιο Layer της εργαλειοθήκης Object Properties 
   
 

ΚΑΡΤΕΛΑ LAYER 
 
 
Show: All Για να βλέπουμε όλα τα επίπεδα 

που υπάρχυν στο σχέδιο που 
δουλεύουμε. 

Current:  Το επίπεδο το οποίο είναι 
ενεργό αυτή τη στιγμή και στο 
οποίο σχεδιάζουμε 

Name:  Όνομα του κάθε 
επιπέδου σχεδίασης. 
 

On / Off On: Όταν τα γεωμετρικά στοιχεία 
που ανήκουν στο συγγεκριμένο 
επίπεδο είναι ορατά 
ανεξάρτητα από αν δουλεύουμε 
σ' αυτό το επίπεδο ή όχι. 

 Off: Όταν τα γεωμετρικά στοιχεία 
που ανήκουν στο συγγεκριμένο 
επίπεδο είναι ορατά ακόμα και 
αν δουλεύουμε σ' αυτό το 
επίπεδο ή όχι. 

Freeze:  Όταν ένα επίπεδο είναι 
«παγωμένο» τότε στην 
σχεδιαστική επιφάνεια δεν 
φαίνονται τα αντικείμενα που 
ανήκουν σ' αυτό το επίπεδο, αλλά 
επίσης τα αντικείμενα αυτά δεν 
συμμετέχουν σ' όλο τον 
σχεδιασμό, (π. χ. δεν 
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επανασχεδιάζονται με την εντολή 
Regen) 
 

 
 
Lock:  Αν κάποιο επίπεδο είναι 

κλειδωμένο, τα γεωμετρικά 
στοιχεία που ανήκουν σ' αυτό το 
επίπεδο εμφανίζονται στο σχέδιο 
αλλά δεν μπορούμε να τα 
τροποποιήσουμε. Μπορούμε 
όπως να τα χρησιμοποιήσουμε 
σαν βάση (σαν βοηθητικά 
αντικείμενα) και να σχεδιάσουμε 
πάνω σ' αυτά καθώς και να 
μαρκάρουμε με τα ΟΛ)]βαΙ δη&ρδ 
χαρακτηριστικά σημεία αυτών 
που θα μας βοηθήσουν στην 
σχεδίαση μας. 
 

Color:  Το χρώμα το οποίο έχουν τα 
αντικείμενα του συγκεκριμένου 
επιπέδου.. 
 

Lineype:  Ο τύπος γραμμής με το οποίο 
σχεδιάζονται τα γεωμετρικά 
στοιχεία του κάθε επιπέδου 

New:  Όταν θέλουμε να 
δημιουργήσουμε ένα νέο επίπεδο 
 

  Όταν δημιουργούμε ένα επίπεδο 
έχοντας μαρκάρει κάποιο από τα 
υφιστάμενα επίπεδα του σχεδίου 
το νέο επίπεδο που δημιουργείται 
έχει εξ αρχής τα χαρακτηριστικά 
(on/ off, freeze, locked/ unlocked, 
color, linetype) που επιπέδου που 
έχουμε μαρκάρει. 
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 Με την δημιουργία του επιπέδου 
του δίνουμε και το όνομα του. Αν 
κάποια στιγμή θέλουμε να 
αλλάξουμε το όνομα ενός 
επίπεδου κάνουμε ένα αριστερό 
κλικ πάνω στο όνομα του. 
 

 Τα μόνα επίπεδα των οποίων το 
όνομα δεν μπορούμε να 
αλλάζουμε είναι το επίπεδο «0» 
και το «ref – depended» 
 

 

 Μπορούμε να δημιουργήσουμε 
πολλά επίπεδα με μία μόνο 
κίνηση, πληκτρολογώντας κόμμα 
μετά από κάθε όνομα- Μόλις 
πληκτρολογήσουμε το κόμμα, 
εμφανίζεται κάθε φορά νέο 
επίπεδο με τα ίδια 
χαρακτηριστικά με το 
προηγούμενο. 
 

  Ο αριθμός των επιπέδων καθώς 
και τα αντικείμενα που μπορεί να 
περιλαμβάνει κάθε επίπεδο είναι 
θεωρητικά άπειρος 
 

Delete  Όταν θέλω να σβήσω ένα 
επίπεδο, το μαρκάρω (κάνοντας 
ένα αριστερό κλικ) στο όνομα του 
και στην συνέχεια πατάω delete.  
Αν στο επίπεδο που θέλουμε να 
διαγράψουμε υπάρχουν 
αντικείμενα, τότε δεν μπορούμε 
να το διαγράψουμε. 
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  Γενικά δεν μπορούν να 
διαγραφούν τα επίπεδα 0, 
Defpointsπου αφορά τις 
διαστάσεις), Ashade (αν έχει 
δωθεί εντολή φωτορεαλισμού), το 
ενεργό επίπεδο, τα επίπεδα που 
εξαρτώνται από τα Χref και 
φυσικά τα επίπεδα που 
περιέχουν αντικείμενα. 
(Χref: Αρχεία εξωτερικών 
αναφορών. Είναι αρχεία που 
έχουν άμεση σχέση με το σχέδιο 
που επεξεργαζόμαστε την 
σχεδιαστική επιφάνεια. Μπορούν 
να είναι οποιαδήποτε εξωτερικά 
αρχεία .dwg τα οποία 
φορτώνουμε ως βοηθητικά στο 
σχέδιο μας. Τα αρχεία αυτά δεν 
θεωρούνται ενεργό μέρος του 
σχεδίου και γι αυτό δεν μπορούν 
να γίνουν explode. ) 
 

Select all:  Επιλέγονται όλα μαζί τα επίπεδα. 
(Αν στην συνέχεια πατήσουμε μία 
από τις επίλογες on lock, freeze 
αυτή η επιλογή εφαρμόζεται σ' 
όλα τα επίπεδα) 
 

Clear all:  Ακυρώνονται οι επιλογές των 
επιπέδων. 
 

 
 

ΚΑΡΤΕΛΑ LINETYPE 
 
Οι αρχικοί τύποι γραμμών που υπάρχουν στο αρχείο 
 
By Layer Τα γεωμετρικά στοιχεία που θα κατασκευαστούν 

υπό αυτή την επιλογή θα σχεδιαστούν με τον 
τύπο γραμμής που έχει οριστεί σ' αυτό το επίπεδο 
 

By block Τα γεωμετρικά στοιχεία που κατασκευάζονται 
υπό αυτή την επιλογή σχεδιάζονται με λευκή 
συνεχόμενη γραμμή. Η επιλογή αυτή 
χρησιμοποιείται για την κατασκευή μπλοκ. Τα 
μπλοκ που κατασκευάζονται κατ'αυτό τον τρόπο, 
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όταν εισάγονται σε κάποιο επίπεδο για το οποίο 
εκείνη την στιγμή της εισαγωγής έχουμε στο 
linetype —> By Layer  αποκτούν τον τύπο 
γραμμής και το χρώμα του αντίστοιχου κάθε φορά 
επιπέδου και δεν έχουν άσπρο χρώμα και λευκή 
συνεχόμενη γραμμή. 
 

 
Continuous Συνεχόμενη 

γραμμή 
Current: Ποιος τύπος 

γραμμής 
είναι αυτή 
την στιγμή 
ενεργός. 

Load: Για φορτώσουμε από το αρχείο του AutoCad ένα 
νέο τύπο γραμμής. Για να σχεδιάσουμε όμως μ' 
αυτό τον τύπο πρέπει να τον κάνω και ενεργό. 
 

Details: Global scale factor Αλλάζουμε την κλίμακα του 
τύπου της γραμμής του επιπέδου. 
 

Make objects layer current Επιλέγω κάποιο αντικείμενο. Το επίπεδο του 
αντικειμένου αυτού γίνεται αμέσως το ενεργό 
επίπεδο. 
 

Layers 
Control 
Color 
Control 
Linetype 
Control 

Ανοίγοντας την λίστα βλέπω το σύνολο των 
επιπέδων που υπάρχουν στο σχέδιο μου, με τα 
χαρακτηριστικά του καθενός. Στα 
χαρακτηριστικά αυτά όταν πρόκειται για (on/off, 
freeze, locked/unlocked) μπορώ να επέμβω για 
να τα αλλάξω ενώ για να αλλάξω το χρώμα και 
τον τύπο γραμμής πάω στο Color control (Line 
control, linetype) αντίστοιχα. 
 

 Μπορώ στο σχέδιο να μαρκάρω ένα αντικείμενο 
και από το Layers Control να το μεταφέρω σ' 
όποιο επίπεδο θέλω. 
 

 
 

ΓΙΑ ΠΟΙΟΥΣ ΛΟΓΟΥΣ ΓΙΝΕΤΑΙ ΣΧΕΔΙΑΣΗ ΣΕ ΔΙΑΦΟΡΕΤΙΚΑ LAYER 
 
Τα επίπεδα Layers μπορούμε να τα παρομοιάσουμε με πολλά διαφανή χαρτιά στα οποία είναι 
σχεδιασμένα διαφορετικά τμήματα του σχεδίου και άμα τα τοποθετήσουμε το ένα πάνω στο άλλο 
συμπληρώνεται και απεικονίζεται όλο το σχέδιο. 



ΤΕΙ ΛΑΡΙΣΑΣ 
ΠΑΡΑΡΤΗΜΑ ΚΑΡΔΙΤΣΑΣ 
ΤΜΗΜΑ ΣΧΕΔΙΑΣΜΟΥ & ΤΕΧΝΟΛΟΓΙΑΣ ΞΥΛΟΥ ΕΠΙΠΛΟΥ 

 

ΕΡΓΑΣΤΗΡΙΑΚΟ ΕΓΧΕΙΡΙΔΙΟ CAD                                                            - 121 - 

Κατά συνέπεια η χρήση των Layers μπορεί να αποδοθεί στο ότι μας δίνουν την δυνατότητα 
ακυρώνοντας προσωρινά ένα ή και περισσότερα επίπεδα να προχωράμε με μεγαλύτερη ευκολία την 
σχεδίαση έχοντας κάθε φορά ορατά μόνο τα αντικείμενα που χρειαζόμαστε. 
 
 

ΠΩΣ ΜΠΟΡΟΥΜΕ ΝΑ ΑΛΛΑΞΟΥΜΕ ΤΟ ΧΡΩΜΑ ΕΝΟΣ ΑΝΤΙΚΕΙΜΕΝΟΥ ΣΤΟ 
ΣΧΕΔΙΟ ΜΑΣ 
 

• Μπορούμε να μεταφέρουμε το αντικείμενο μας σε ένα άλλο επίπεδο με αποτέλεσμα με την 
μεταφορά αυτή να αλλάζει το χρώμα του και να αποκτά το χρώμα του επιπέδου στο οποίο 
μεταφέρεται 

• Μπορούμε με την εντολή Match Properties να «κλέψουμε» τις ιδιότητες ενός αντικειμένου 
που έχει το χρώμα του θέλουμε (ανήκοντας στο κατάλληλο επίπεδο) και να τις μεταφέρουμε 
στο ζητούμενο αντικείμενο του οποίου το χρώμα θέλουμε να αλλάξουμε. (Στην ουσία και με 
αυτή την κίνηση μεταφέρουμε το αντικείμενο του οποίου το χρώμα θέλουμε να αλλάξουμε 
στο επίπεδο που έχει το επιδιωκόμενο χρώμα). 

• Μπορούμε με την εντολή Properties δούμε τις ιδιότητες του αντικειμένου του οποίου θέλουμε 
να αλλάξουμε το χρώμα, και από την επιλογή Color να του δώσουμε το νέο χρώμα που 
θέλουμε. 

 
 

ΠΩΣ ΜΠΟΡΟΥΜΕ ΝΑ ΑΛΛΑΞΟΥΜΕ ΤΟΝ ΤΥΠΟ ΓΡΑΜΜΗΣ ΕΝΟΣ ΣΥΝΟΛΟΥ Η 
ΕΝΟΣ ΑΝΤΙΚΕΙΜΕΝΟΥ ΣΤΟ ΣΧΕΔΙΟ ΜΑΣ 
 

• Μπορούμε να αλλάξουμε το linetype ενός ολόκληρου επιπέδου, με αποτέλεσμα όλα τα 
αντικείμενα που ανήκουν σ' αυτό το επίπεδο να προσαρμόσουν ανάλογα τον τύπο γραμμής 
τους. 

 
• Μπορούμε με την εντολή Match Properties να «κλέψουμε» τις ιδιότητες ενός αντικειμένου 

που έχει το χρώμα του θέλουμε (ανήκοντας στο κατάλληλο επίπεδο) και να τις μεταφέρουμε 
στο ζητούμενο αντικείμενο του οποίου το χρώμα θέλουμε να αλλάξουμε. (Στην ουσία και με 
αυτή την κίνηση μεταφέρουμε το αντικείμενο του οποίου το χρώμα θέλουμε να αλλάξουμε 
στο επίπεδο που έχει το επιδιωκόμενο χρώμα). 

• Μπορούμε με την εντολή Properties δούμε τις ιδιότητες του αντικειμένου του οποίου θέλουμε 
να αλλάξουμε το χρώμα, και από την επιλογή €ο\οτ να του δώσουμε το νέο χρώμα που 
θέλουμε. 

 
 
ΠΩΣ ΜΠΟΡΟΥΜΕ ΝΑ «ΚΡΥΨΟΥΜΕ» Ή ΝΑ «ΕΜΦΑΝΙΣΟΥΜΕ» ΑΝΤΙΚΕΙΜΕΝΑ 
ΣΤΗΝ ΟΘΟΝΗ 
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• Μπαίνοντας στον κατάλογο των επιπέδων και ανοίγοντας και κλείνοντας (ΟΝ/ΟFF) τα 
επίπεδα των οποίων τα αντικείμενα θέλουμε να εμφανιστούν ή να κρυφθούν αντίστοιχα. 

• Μπαίνοντας στον κατάλογο των επιπέδων και «παγώνοντας» επίπεδα μπορούμε επίσης να 
κρύψουμε αντικείμενα από τον χώρο σχεδίασης και αντίθετα. 

• (Η διαφορά μεταξύ της εντολής ΟFF και FREEZE είναι ότι τα αντικείμενα των επιπέδων που 
είναι παγωμένα δεν εμφανίζονται στην οθόνη αλλά ούτε συμμετέχουν στην σχεδίαση. Ενώ τα 
αντικείμενα των επιπέδων που είναι ΟFF δεν εμφανίζονται στην οθόνη αλλά συμμετέχουν 
στην σχεδίαση (κάνοντας αναπαραγωγή του σχεδίου αναπαράγονται και αυτά. 

• Η δυνατότητα να «κρύβουμε» ή να «εμφανίζουμε» αντικείμενα διευκολύνει τον σχεδιασμό, 
καθώς η εξαφάνιση αντικειμένων, των οποίων η παρουσία δεν είναι απαραίτητη, ανοίγει την 
σχεδιαστική επιφάνεια. 

 
 
ΠΩΣ ΑΛΛΑΖΟΥΜΕ ΤΟ ΟΝΟΜΑ ΕΝΟΣ ΕΠΙΠΕΔΟΥ ΣΧΕΔΙΑΣΗΣ 
 
Από την εντολή Layers μπαίνουμε στον κατάλογο των επιπέδων στον οποίο μπορούμε να κάνουμε αλλαγές. 
Κάνοντας ένα αριστερό κλίκ στο όνομα, ανοίγει το πλαίσιο του ονόματος στο οποίο μπορούμε να 
πληκτρολογήσουμε το νέο όνομα του επιπέδου και να το επικυρώσουμε με enter. Δεν μπορούμε να να 
αλλάξουμε το όνομα του Layer 0 
 
 
ΤΙ ΣΗΜΑΙΝΕΙ Η ΕΝΤΟΛΗ ΒΥLAYER των εντολών COLOR και LINEΤΥΡΕ 
 
Είναι η εξ ορισμού ρύθμιση για το χρώμα και τον τύπο γραμμής των αντικειμένων που σχεδιάζουμε. Αν τα 
αντικείμενα είναι Bylayer παίρνουν το χρώμα και τον τύπο γραμμής του ενεργού επιπέδου. 
 
ΠΩΣ ΜΠΟΡΕΊ ΝΑ ΕΧΟΥΜΕ ΣΤΟ ΙΔΙΟ LAYER ΑΝΤΙΚΕΙΜΕΝΑ ΔΙΑΦΟΡΕΤΙΚΩΝ 
ΧΡΩΜΑΤΩΝ 
 
Μπορούμε με την εντολή Properties δούμε τις ιδιότητες του αντικειμένου του οποίου θέλουμε να αλλάξουμε το 
χρώμα, και από την επιλογή COLOR να του δώσουμε το νέο χρώμα που θέλουμε. Έτσι το αντικείμενο έχει 
διαφορετικό χρώμα αλλά χωρίς να έχει αλλάξει επίπεδο. 
 
ΜΕΤΑΦΟΡΑ ΕΝΟΣ ΑΝΤΙΚΕΙΜΕΝΟΥ ΣΕ ΑΛΛΟ LAYER ΕΑΥΕΚ 
 

• Επιλέγουμε το αντικείμενο που θέλουμε να μεταφέρουμε χωρίς να έχουμε ενεργοποιήσει κάποια 
εντολή και χωρίς να ενεργοποιήσουμε και μετά την επιλογή. Στην συνέχεια από το Layer Control 
επιλέγουμε το επίπεδο στο οποίο θέλουμε να μεταφερθεί το αντικείμενο. 

 
• Μπορούμε με την εντολή Match Properties να «κλέψουμε» τις ιδιότητες ενός αντικειμένου που 

έχει το χρώμα του θέλουμε (ανήκοντας στο κατάλληλο επίπεδο) και να τις μεταφέρουμε στο 
ζητούμενο αντικείμενο του οποίου το χρώμα θέλουμε να αλλάξουμε. (Στην ουσία και με αυτή 
την κίνηση μεταφέρουμε το αντικείμενο του οποίου το χρώμα θέλουμε να αλλάξουμε στο 
επίπεδο που έχει το επιδιωκόμενο χρώμα). 

 
 

ΧΑΡΑΚΤΗΡΙΣΤΙΚΑ ΕΝΟΣ LOCKED LAYER 
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Αν κάποιο αντικείμενο επίπεδο είναι κλειδωμένο, τα αντικείμενα του εμφανίζονται μεν στο σχέδιο αλλά δεν 
μπορούμε να τα τροποποιήσουμε. Μπορούμε όμως να σχεδιάσουμε πάνω σ' αυτά νέα αντικείμενα και να 
χρησιμοποιήσουμε το Object Snaps 
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ΔΕΚΑΤΗ ΤΕΤΑΡΤΗ ΕΡΓΑΣΤΗΡΙΑΚΗ ΕΝΟΤΗΤΑ : ΕΙΣΑΓΩΓΗ ΤΗΣ ΕΝΤΟΛΗ ΓΙΑ ΤΗΝ ΔΗΜΙΟΥΡΓΙΑ 
FORMAT / TEXT STYLE 

 

 

 

Παρατήρηση 

Κάθε φορά που κάνω αλλαγή στο Format/Text style αλλάζουν αυτόματα και όλα τα κείμενα που ‘εχω γράψει 
στο σχέδιό μου σαν single line text και ενημερώνονται σύμφωνα με την τελευταία αλλαγή που κάνω στο 
Format / Text style. 

 

 

Παρατήρηση 

Με την επιλογή Simgle Line text γράφω τα κείμενά μου γραμμή γραμμή με βάση τις παραμέτρους που 
καθορίζω από το Format/ Text line ενώ με την επιλογή μου Multiline text καθορίζω επιτόπου τις παραμέτρους 
του κειμένου μου και μπορώ σε διαφορετικά σημεία του σχεδίου μου να έχω διαφορετικούς τύπους κειμένου. 
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ΔΕΚΑΤΗ ΠΕΜΠΤΗ ΕΡΓΑΣΤΗΡΙΑΚΗ ΕΝΟΤΗΤΑ : ΕΙΣΑΓΩΓΗ ΤΗΣ ΕΝΤΟΛΗ ΓΙΑ ΤΗΝ ΔΗΜΙΟΥΡΓΙΑ 
FORMAT / TEXT STYLE 
 
Για την εισαγωγή διαστάσεων στα σχέδια. Η εισαγωγή διαστάσεων γίνεται σε 2 βήματα. Αρχικά καθορίζουμε 
τον τρόπο εμφάνισης των διαστάσεων στο σχέδιο (Format / Dimension Style) και στη συνέχεια ορίζουμε τα 
γεωμετρικά στοιχεία που θέλουμε να διαστασιολογηθούν. 
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ΔΕΚΑΤΗ ΕΚΤΗ ΕΡΓΑΣΤΗΡΙΑΚΗ ΕΝΟΤΗΤΑ : ΕΙΣΑΓΩΓΗ ΤΗΣ ΕΝΤΟΛΗ STRETCH 
 
Με την εντολή Stretch αλλάζουε την μορφή στοιχείων «τεντώνοντας» τμήματα τους. 
 
ΕΙΣΑΓΩΓΗ ΤΗΣ ΕΝΤΟΛΗΣ: 
 

Command:                   Stretch ↲ 

Pull down menu:           Modify   →   stretch 
Εικονίδια:         Ενεργοποιούμε το εικονίδιο stretch της εργαλειοθήκης Modify 
 
ΥΠΟΜΕΝΟΥ ΤΗΣ ΕΝΤΟΛΗΣ: 
 
 
Command: _stretch 
Select objects to stretch by crossing-window or crossing-polygon... 
 
Επιλέγουμε τα γεωμετρικά στοιχεία τα οποία θέλουμε να «τανίσουμε». Η επιλογή γίνεται με πλαίσιο (crossing 
window), κινούμενοι από δεξιά προς τα αριστερά. Τα τμήματα των οποίων το μέγεθος θέλουμε να αλλάξει 
πρέπει να τέμνονται από το πλαίσιο ενώ τα τμήματα των οποίων αλλάζει μόνο η θέση (δηλαδή μετατίθενται) 
πρέπει να περιέχονται ολόκληρα μέσα στο πλαίσιο. 
 
 
Base point or displacement: 
Ορίζουμε από ποιο σημείο θα πιάσουμε το επιλεγμένο αντικείμενα για να τα τονίσουμε. 
 
 
 
Second point or displacement: 
Ορίζουμε ποια θα είναι η τελική θέση του σημείου από το οποίο πιάνουμε το αντικείμενο για να το 
τονίσουμε. Η τελική θέση ορίζεται με απόλυτες καρτεσιανές συντεταγμένες (χ, ψ) με σχετικές καρτεσιανές 
συντεταγμένες (@ dx, dy) ή με σχετικές πολικές συντεταγμένες (@ 1<φ) 
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ΛΥΜΕΝΗ ΑΣΚΗΣΗ: 
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ΛΥΣΗ ΤΩΝ ΑΣΚΗΣΕΩΝ: 
 
Σχεδιάζουμε το αρχικό σχήμα. 

 
 
Επιλέγουμε την εντολή Stretch από την εργαλειοθήκη. 
 

 
 
Επιλέγουμε τις πλευρές του αντικειμένου που θέλω να τανύσω. 
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Κάνω δεξί κλικ και επιλέγω το σημείο που θα μετακινήσω. 
 

 
 
 
Η επιλογή ORTHO είναι ενεργοποιημένη. Μετακινώ τον κέρσορα προς την κατεύθυνση που θα συρρικνωθεί 
(κατά 1 μονάδα) το αντικείμενο. 

 
 
Δίνω την επιλογή 1 σχεδιαστικές μονάδες και Enter. 
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ΑΣΚΗΣΕΙΣ ΠΡΟΣ ΛΥΣΗ: 
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ΔΕΚΑΤΗ ΕΒΔΟΜΗ ΕΡΓΑΣΤΗΡΙΑΚΗ ΕΝΟΤΗΤΑ : ΕΙΣΑΓΩΓΗ ΤΗΣ ΕΝΤΟΛΗ ARC 
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ΛΥΜΕΝΗ ΑΣΚΗΣΗ: 
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ΛΥΣΗ ΤΩΝ ΑΣΚΗΣΕΩΝ: 
 
Αρχικά σχεδιάζω την χορδή των 8 σχεδιαστικών μονάδων. 

 
 
Σχεδιάζω το κέντρο του τόξου με περιεχόμενη γωνία 1400. Το κέντρο γίνεται με την τομή των δύο πλευρών οι οποίες 
έχουν περιεχόμενη γωνία με την χορδή 200. 
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Σχεδιάζω την κάθετη πλευρά του αριστερού πλάγιου τόξου. 

 
 
Σχεδιάζω την πλάγια πλευρά του αριστερού πλάγιου τόξου. 
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Επιλέγω το τόξο αρχή, τέλος, γωνία. 

 
 
Τσεκάρω το πρώτο σημείο. 

 
 
Τσεκάρω το δεύτερο σημείο. 
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Δίνω την γωνία 1400. 
 

 
 
Όμοια κάνω και το δεύτερο τόξο. 
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ΑΣΚΗΣΕΙΣ ΠΡΟΣ ΛΥΣΗ: 
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